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What is Print Client?

Print Client is an application that lets you send formatted print files to a print server to be printed.    Print 
Client lets you set up sessions to different print servers and their printers.

Print Client can only print files that have been put in a format that a printer can understand.    Examples 
are ASCII text files or Postscript files.    

Using Print Client to send an unformatted file, for example word processor .doc file, will result in the 
printer printing out pages of meaningless characters.

The main window displays the name of the current session, if any, and the current queues and their 
status. You can select a different session.

Dialog Box Items
Session
Queue Status

Related Topics
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Create or Edit a Session

To create a session
1. From the Session menu, choose New.

--or--
Choose the New Session button from the toolbar.

The New Session dialog box opens.
2. Enter a Session Name, Server Name, and Queue Name for the new session.
3. Choose OK.

To edit a session
1. In the Session box of the Print Client main window, select the session you want to edit.

2. From the Session menu, choose Edit.
--or--

Choose the Edit Session button from the toolbar.

The Edit Session dialog box opens.
3. Edit the fields you want to modify.
4. Choose OK.

Dialog Box Items
Session Name
Server Name
Queue Name

Advanced >>

File Format
Print Banner Page
Copies
Class
Save As Default Session

Related Topics
Delete a Session
Make a Session the Default
What is a Session?
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Delete a Session
1. In the Session box of the Print Client main window, select the session you want to delete.

2. From the Session menu choose Delete.
--or--

Choose the Delete Session button from the toolbar.

You are prompted to confirm that you really want to delete the session.
3. Choose Yes.

Related Topics
What is a Session?
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Making a Default Session
1. In the session box of the Print Client main window, select the session that you want to make the 

default.

2. From the Session menu, choose Edit.

3. In the Edit Session dialog box, choose the Advanced button.

The Edit Session dialog box expands to include more options.

4. Select the Save as Default Session check box.

5. Choose OK.

Related Topics
Create or Edit a Session
Delete a Session
What is a Session?
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Customize the Print Client Command Line

Print Client lets you configure icons to open predefined sessions to a specific print server as soon as 
you choose the icon.    Using the Windows Program Manager, you can create as many icons as you 
want.

To customize a Print Client icon
1. In Windows Program Manager, select the Print Client icon.

2. From the File menu in Windows Program Manager, choose Properties.

Program Manager displays the Program Item Properties dialog box. 

3. In the Command Line box, specify the filename WLPR, followed by the command line option -s 
session-name.    For example, the command line for a print session called printme would look like 
this:

wlpr -s printme

4. In the Description box, name the icon to reflect how you have customized it. For example, if the 
command line specifies a connection to print server ABC, you might name the connection ABC.

5. Choose OK.

Related Topics
Create or Edit a Session
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Print a Formatted Print File
1. In the Session box of the Print Client main window, select the session you want to use.

2. From the Commands menu, choose Print Files.
--or--

Choose the Print Files button from the toolbar.

The Select Files to Print dialog box opens.
3. Select the file(s) you want to print.
4. Choose Ok.

The file(s) is printed on the printer specified in the currently open session.    
When Print Client prints a job, it then immediately sends a query command to that print server, 

and then displays the results in the Print Client window.    Note that sometimes the LPD print server that 
Print Client is connected to may be too slow or too fast to correctly display the updated status.

Related Topics
Print a file without a session
Query a Printer Queues Status
Stop a Print Job
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Printing a File without a Session
1. In the Session box, choose none.

2. From the Commands menu, choose Print Files.
--or--

Choose the Print Files button from the toolbar.

The Print Files dialog box opens.
3. Enter the file you want to print.

--or--
Choose the Browse button and choose the file(s) you want to print.

4. Enter the Server name.

5. Enter the Queue name.

6. Choose Ok.

The file is printed on the printer you have specified.    

When Print Client prints a job, it then immediatly sends a query command to that print server, and 
then displays the results in the Print Client window.    Note that sometimes the LPD server that Print 
Client is connected to may be too slow or too fast to correctly display the updated status.

Dialog Box Items
File Name
Browse

Server Name
Queue Name

Advanced >>

File Format
Print Banner Page
Copies
Class

Related Topics
Print a file
Query a Printer Queues Status
Stop a Print Job
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Selecting Files to Print
1. In the Select File to Print dialog box, choose the drive and directory where the file or files you want to

print are stored.

2. In the list box on the left, select the file you want to print.

To select more than one file, hold down the CTRL key, and select each file you want to print.

--or--
To select a block of consecutive files, select the first file, hold down the Shift key, and then select the 
last file.

3. Choose OK.

Related Topics
Print a file without a session
Print a file
Query a Printer Queues Status
Stop a Print Job

Introduction
Step-by-Step Instructions
Concepts



Print a File Using Drag and Drop
1. From Windows File Manager, select the formatted print file you want to print.

2. Drag the file anywhere inside the Print Client main window, or onto the Print Client icon, and release 
the mouse button.

Related Topics
Query a Printer Queues Status
Stop a Print Job
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Stop a Print Job
1. From the Commands menu, choose Remove Job.

--or--
Choose the Remove Job button from the toolbar.

The Remove Print Jobs dialog box opens.
2. Type the job number of the print job you want to stop in the dialog box.

You can get this number by querying the print server.
3. If you did not use a defined session to send the print job, you must also specify the Server name 
and Queue name of the job you want to remove.
4. Choose OK.

When Print Client cancels the print job, it then immediately sends a query command to that print 
server, and then displays the results in the Print Client window.

You can also stop a print job using the Print client window.

Dialog Box Items
Server Name
Queue Name
Job Numbers

Related Topics
Query a Printer Queue
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Stop a Print Job from the Print Client Main Window
1. Use your pointer to highlight the job in the Print Client main window.

2. From the Commands menu, choose Remove job.

The Remove Print Jobs dialog box opens with the print job number displayed.

Note that this works only if the job number is the first number on the line in the Print Client main 
window.    Different print servers send the information from a query back in different ways, so this 
does not always work.

3. Choose OK.

Related Topics
Query a Printer Queue
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Query a Printer Queues Status
1. In the Session box of the Print Client main window, select the session that points to the queue you 

want to query.

2. From the Commands menu, choose Query Status.
--or--

Choose the Query Status button from the toolbar.

The server returns status messages to the Print Client window.

Related Topics
Print a file
Stop a Print Job
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Query a Printer Queues Status Without a Session
1. From the Commands menu, choose Query Status.

--or--
Choose the Query Status button from the toolbar.

The Query Printer dialog box opens.
2. Enter the server and queue name of the queue you want to query.
3. Choose OK.

The server returns status messages to the Print Client window.

Dialog Box Items
Server Name
Queue Name

Related Topics
Print a file
Query a Printer Queues Status
Stop a Print Job

Introduction
Step-by-Step Instructions
Concepts



What is a Session?

In Print Client a session is a group of parameters that you set up and name to represent a connection to 
a print server and queue.

In addition to specitying the server and queue name, you can also associate a session with a file format,
a class, a number of copies to print, and whether to print a banner page.

Related Topics
Create or Edit a Session
Delete a Session
Edit a Session
Make a Session the Default
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Using Print Client with Network Control

Print Client uses the same sessions as PC/TCP Network Control does in its printers section.    Both 
applications can be used at the same time; however, make sure not to edit the same session in both 
applications at the same time.    

If you do make changes to a session in one application, be sure to close out of the other application, 
and reopen the session before proceeding.

Related Topics
Edit a Session
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The Session Menu

Use the Session menu to create, edit, or delete Print Client sessions.

Use this To do this
New Create a new session.

Edit Make changes to an existing session.

Delete Delete an existing session.

Exit Exit Print Client.

Related Topics
Introduction
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The Commands Menu

Use the Commands menu to start and stop print jobs, and to query a print server.

Use this To do this
Print File Print a formatted print file.

Query Status Query the status of a print server.

Remove Job Remove a print job from a printer queue.

Related Topics
Introduction
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The View Menu

Use the View menu to change the Print Client display.

Use this To do this
Toolbar Display and hide the toolbar.

Status Bar Display and hide the Status bar.

Related Topics
Introduction
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ASCII
An acronym for American Standard Code for Information Interchange. A standard computer character 
set used in text files.    ASCII files do not contain program or formatting instructions.



Session
A session definition includes the settings, such as name of a print server on the network, and a queue 
name on that server, as well as other values that you select for a session.    

Sessions allow you to set the way you frequently want files printed in advance.



Print Server
A print server is an application that is configured to provide print services to a network.    When a file is 
sent to a print server, the server then redirects the file to the proper printer for actual printing. 



Printer Queue
A printer queue is a virtual printer that has a specific configuration.    Using a print server, you can create 
several queues for a single printer so that different queues (with different configurations) print different 
types of files or produce different output (such as printing in different fonts).



Formatted Print File
Print Client can only print files that have been put in a format that a printer can understand.    Examples 
are ASCII text files or Postscript files.    

Using Print Client to send an unformatted file, for example word processor .doc file, will result in the 
printer printing out pages of meaningless characters.



Banner Page
A banner page, also known as a header page, is a page that a printer prints before each job.    The 
banner page usually lists the username of the person who sent the job, as well as the name and number
of the job.



Class
Specifies a name that prints on the print jobs .banner page.    This class name can be used as a project 
or group name.



Type a name for the session.

Type the name of the print server to be
used with the session.

Type the queuename or use the 
default lp queuename.

Display and set additional session 
options.

Choose the type of file formats to be 
used with this session.

Have a header page print at the 
beginning of each print job.

Set the number of copies printed for 
each job.

Type a class to be used with this 
session.

Make this session the default session 
that Print Client loads when it first 
starts.

Enter the job number of the print job 
you want to remove.    Get job numbers
by querying the print server.

If you are not working from a session, 
type the name of the server from which
you want to remove a job.

If you are not working from a session, 
type the name of the queue from which
you want to remove a job.

Enter the job number of the print job 
you want to remove.    Get job numbers
by querying the print server.

Type the name of the file you want to 
print.

Type the name of the print server you 
want to send this print job to.

Type the name of the print queue you 
want to send this print job to.

Select the type of file format to be used
with this print job.

Have a header page print at the 
beginning of each print job.

Type a class to be used with this print 



job.

Set the number of copies printed for 
this print job.

View messages returned from the print
server.    Use the Query Status 
command to query a queue.

View messages that have been sent 
by the print server.    You can also use 
the pointer to highlight a job number 
for deletion.

Select an existing session that you 
want print client to use. If you select a 
session, you see the server and queue
names. If you select <none>, you see 
only the default queue name, lp.

Enter a number of copies of each job 
to be printed when using this session.

Choose this button to expand the 
dialog box and set more options.

Enter the name of the server you want 
to query.

Enter the name of the queue you want 
to query.



account name: The name or word that identifes who is billed for 
this session on a computer system.

case sensitivity: The ability of a program to evalutate the difference
between the capitalized and non-capitalized versions of a character. 
Case sensitive programs treat for example, cat and Cat, as distinct 
items.

It matters how you enter file and variable names on a case sensitive 
operating system (such as the UNIX operating system). If you want 
to view a file named Cat, and you enter the characters cat,    the 
system displays the file named cat if one exists, or gives you an 
error message. It does not display a file named Cat. Case sensitivity
also effects the way that files are listed when sorted in alphabetical 
order.
.

filename conventions: A TCP/IP network usually contains 
computers that run different operating systems. Each operating 
system has different conventions for naming files. For example, both
the number and kinds of characters that can be used in a name are 
often subject to limits.

When you use some TCP/IP supported services such as telnet and 
ftp, use the filenaming conventions in effect on the host system to 
work with files that are on the host.

hostname: The name of a networked computer. 

The hostname is one form of the computers TCP/IP network 
address; the other is its complete numeric network address.You can 
access a computer by its hostname or its numeric network address.

toolbar: A group of buttons that appears below the menu bar. These
buttons let you gain access quickly to the application's features.

IP address: A number (in the form n.n.n.n    where each n is a value 
in the range 0 to 255) that uniquely identifies a networked computer 
that uses the TCP/IP communication protocol. (The Internet Protocol
is defined in RFC 791.)

MIB-II: The Management Information Base (MIB) database used by 
an SNMP MIB agent to store information about the network 
operations of your PC. MIB-II (or MIB version 2) is the second 
version of the Internet-standard MIB. RFC 1213 defines the format 
of MIB-II.

packet: A single network message with its associated header, 
addressing information, data, and optional trailer. Also known as a 
"frame" or "datagram".

password: A word or string of characters that you supply in order to 
login to another system on a network. Systems that accept the 
username "anonymous" often require you to provide your e-mail 
address as the password.

permissions: On UNIX systems, settings that control who has 
access to a file and what rights (read, write, or execute) are given. 
NFS uses UNIX-style permissions to control access to network files.



protocol window: Some OnNet applications support a window 
dedicated to displaying the interactions between your PC and the 
remote host (the protocol). You can display the window usually from a
View, Settings, or Options menu.

remote host: A networked computer that makes a service available 
to other computers on the network. Typical host services include 
transferring files, printing files, and managing logins from remote 
users.

SNMP community: A relationship between an SNMP agent and one 
or more SNMP management stations.

SNMP community name: A unique name shared by the members of 
an SNMP community.

SNMP message: A packet of data, consisting of an SNMP 
community name and SNMP commands and operands.

status bar: A message area, typically at the bottom of the application 
window, that provides information about the component that is currently 
selected, or the state of the application.

session: A session comprises the interactions between your PC and a 
remote host    beginning with the initial connection and ending when you
or the host explicitly disconnect. 

Some OnNet applications allow you to configure sessions, that is, 
automatically send parameters such as your username and password 
to the remote host..

session definition: The configuration settings for a particular session 
or host connection. A session definition might include such settings as 
the hostname of a computer on the network and your login name for 
that computer, as well as other values that you specify. The set of 
session parameters you can specify differs with each program.

TCP (Transmission Control Protocol): A Transport layer, connection-
oriented, end-to-end protocol that provides reliable, sequenced, and 
nonduplicated delivery of bytes to a remote or a local user. TCP 
provides reliable byte stream communication between pairs of 
processes in hosts attached to interconnected networks.

time out: A period of time when a connection between a PC and a    
host computer is allowed to be idle or unused, or when a PC can 
attempt to make a connection to a networked host.. 

When the time period elapses, the host closes the idle connection, or 
the PC reports that it failed to connect to a host.

UDP (User Datagram Protocol): A Transport layer, connection-less 
mode protocol providing a (potentially unreliable, unsequenced, and/or 
duplicated) datagram communication for delivery of packets to a remote
or a local user. UDP provides a procedure for a process to send 
messages to other processes with a minimum of protocol mechanism.

username: A name required for login to a remote system.

wildcard:    A character such as * or ? that represents one or more 
characters in a filename. In a network, each operating system supports 



its own wildcard characters and syntax. When you use wildcards on a 
remote host, follow the conventions that apply to that host.



Displays or hides additional elements of this dialog box.

Returns to the previous dialog box.

Displays the Open dialog box so that you can search for 
a specific file.

Cancels your selection(s) and close the dialog box 
without taking any action.

Closes the dialog box.

Exits the application.

Displays Help about the contents of this dialog box.

Does not proceed as indicated.

Proceeds to the next dialog box.

Confirms your selection(s) and close the dialog box.

Opens the Options dialog box.

Enter a word or string of characters to log in to another 
system, workgroup, or domain on a network.

Protects the contents of the file from modification.

Starts the operation.

Stops the operation.

Starts or stops the operation.

Enter the hostname or IP address of the 
remote host that you are trying to reach.

Enter the name that you use to log in to a computer on a 
network.

Proceeds as indicated.

Proceeds as indicated and avoids further prompts for 
confirmation.

Click this to set up options,

Saves all the changes you have 
made without closing the dialog box.

Context-sensitive help for this 
item is not yet implemented.

Help for this dialog box is not yet implemented.





Technical assistance

Users in the U.S. and Canada, and worldwide resellers    Contact FTP Software®:

Telephone: (800) 382-4387
(508) 685-3600

E-mail: support@ftp.com
Fax: (508) 794-4484

 or 

Users outside of the U.S. and Canada    Contact your local reseller.

Tip
For FREE online technical services, see:

World Wide Web: http://www.ftp.com
Anonymous Ftp Server: ftp.ftp.com
Bulletin Board System: (508) 684-6240 ( settings    8,N,1)
CompuServe: GO FTPSOFT (PCVENJ Section 8)




